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IInnssttaalllliinngg CCCCPP oonn VViissttaa oorr XXPP PPCCss

YYoouu NNeeeedd aa PPeerrssoonnaall CCoommppuutteerr WWiitthh aa UUSSBB PPoorrtt  

CCP will run on any Pentium II or faster Windows PC. Your PC should be equipped with an adequate amount of
RAM for the operating system you use. CCP is compatible with the Windows 2000, XP and Vista operating systems.
It is not compatible with Windows ME, 98 or previous versions of Windows.

CCP is installed via a self extracting installer file downloadable from our installer only website:
www.urccontrolroom.com.

IInnssttaalllliinngg CCCCPP aanndd MMiiccrroossoofftt AAccttiivveeSSyynncc  

CCP installs with a companion program for communication, Microsoft ActiveSync.You must install both programs and
if un-installing, un-install both programs.To install the two programs, follow these steps:

11 Connect to our installer only website www.urccontrolroom.com and naviagate to Software Downloads,
then select CCP to download.

22 A file download Window will open. Click on OPEN.

33 The InstallShield Wizard Window for the CCP will open. Click on NEXT

44 The Install Destination Window will then open. Click on NEXT.

55 The Ready to Install Window will open. Click on INSTALL.

66 The program will install and then show that installation has been completed. Click on FINISH.

77 A new small window will open asking, "Install the Microsoft Active Sync 3.7". Click OK.

88 A new set up window will open for ActiveSync 3.7. Click on NEXT.

11IInnssttaalllliinngg

M
X
9
8
0

C
O
L
O
R

L
C
D

R
E
M
O
T
E

CCP



22 TTyyppee iinn SSeeccttiioonn TTiittllee

U
S
I
N
G

C
C
P

T
O

P
R
O
G
R
A
M

99 A new window will open to select the installation folder. Simply click on NEXT.

1100 A new window titled "Get Connected" will open. DDoo nnoott ddoo cclliicckk oonn aannyy bbuuttttoonn iinn tthhee ““GGeett CCoonnnneecctteedd””
wwiinnddooww yyeett..

1111 Wait for the the Active Sync “Install” window to appear and then click “OK”.

1122 At this point plug the USB cable into your computer and then the MX-6000 Remote.

1133 The Get Connected Window will close and then a "Set Up a Partnership" Window will open. At this point
you are offered two choices. WWaarrnniinngg!! IInnssttaalllleerrss sshhoouulldd nnoott cchhoooossee YYeess - This will set up a partnership
with that particular MX-6000. Every time the same MX-6000 is plugged in, it will automatically establish

IInnssttaalllliinngg

The Get Connected
window will automati-
cally update. 
Do not click on NEXT.
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the connection, but it will not recognize new MX-6000s.

AAllwwaayyss cchhoooossee NNoo -- TThhiiss iiss bbeesstt ffoorr iinnssttaalllleerrss, as you will be programming multiple MX-6000's.This is
considered a "Guest" partnership. Each time that the MX-6000 is plugged in, it will open the get connected
window and the programmer will need to click "No" to establish a connection with the MX-6000.

After clicking No, the Microsoft ActiveSync Window will open and show that a "Guest" connection has
been established.

KKeeeepp YYoouurr DDaattaabbaassee UUpp ttoo DDaattee —— UUSSEE LLIIVVEE UUPPDDAATTEE  

CCP includes a vast library of IR codes for hundreds of brands and models of A/V components.This database is con-
stantly growing with the inclusion of new devices every month. Keep your software up to date by using the Live
Update feature. Rather than un-installing and re-installing the software, you download updates to the software from
the internet. Simply follow these steps:

11 CCoonnnneecctt ttoo tthhee IInntteerrnneett nnoorrmmaallllyy..

22 OOppeenn CCCCPP..

33 FFrroomm tthhee CCoommmmuunniiccaattiioonnss MMeennuu,, sseelleecctt LLiivvee UUppddaattee..

44 IInn tthhee LLiivvee UUppddaattee wwiinnddooww,, cclliicckk oonn ““OOKK”” ttoo ssttaarrtt tthhee uuppddaattee pprrccooeessss.. TThhee pprroocceessss wwiillll aauuttoommaattiiccaallllyy
cclloossee CCCCPP..

55 WWaaiitt ffoorr tthhee pprrooggrreessss wwiinnddooww ttoo iinnddiiccaattee ““UUppddaattee DDoonnee””,, tthheenn cclliicckk oonn ““OOKK””..

66 CCCCPP iiss aauuttoommaattiiccaallllyy rreessttaarrtteedd aanndd rreeaaddyy ttoo ggoo.. TThheerree iiss nnoo nneeeedd ttoo rreessttaarrtt WWiinnddoowwss..

IInnssttaalllliinngg
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Introducing CCP - The Complete Control Program for MX-980 and more...

Menus and Shortcut buttons for common tasks. The Program Menu activates each task in the correct order.

Home Designer and Model Designer Tree Views of the MX-6000 configuration. Double clicking on any page
enables you to quickly display that page on the simulator view. Right clicking on a device or page activates a 
context menu.

The MX-6000 Simulate View is used to navigate and to select a button to program, edit or record a macro.

Multi-tabbed Tool window allows access to the  “IR Navigator”, “Button, Page and Device Properties”,“Image
Gallery”,“Sound Gallery” and “Serial Database”.

The tabs select whether you want Properties or one of the tools displayed in the window above.

The Macro window is used to view and edit macros.

IInnttrroodduucciinngg CCCCPP

AA

BB

CC

DD

EE

FF

Home
Designer

Model
Designer

Simulate VSimulate Viewiew

Macro Window

AA

BB CC DD

FF

EE

Main Menu and Toolbar

Properties/
Tool Window

Select via
Tabs (E)



Overview of the New Features of CCP

Complete Control Program represents a full house philosophy to programming, giving you tools to quickly program
multiple remotes in one file. You’ll find tree view is now split into two areas, one area called House Designer, which
enables you to select remotes or base stations based on what room they are in.

To configure a remote or a base station, you must DOUBLE CLICK it in Home
Designer.

The selected remote or base station is then placed into the Model Designer tree
view.To configure properties or a particular remote control page, DOUBLE
CLICK it in Model Designer.

Once a remote is selected, clicking on the Program tab will reveal the standard URC programming steps. Simply move
from left to right in sequence to program the remote completely.

To add new rooms, remotes or basestations to your file, you can either:

11 Right Click on Home in House Designer and select Add Room.This will open the System Configuration
window.

OR
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NNeeww FFeeaattuurreess



22 Click on the Program tab and select “Configure Home” (House Designer) from the far left of the Program
ribbon.

This will open the System Configuration window:

33 Once the House Designer window is open, simply drag rooms to “Home”, then drag remotes and/or base
stations to each room as needed. See page xx for a detailed explanation.

TIP - Don’t add remotes to rooms until your first remote is finished.When adding remotes, you can copy the first
remote you’ve done, which will save effort on your second remote.

66 NNeeww FFeeaattuurreess
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NOTE: Drag remotes or base
stations on top of the room
to add to room. You cannot
drag to the items inside the
room directly.
It’s easier to just select the
product and the room and
click on the ADD button.
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Customizing the Workspace

CCP has some unique layout features that allow you to customize your own personal layout.

Here is the default layout: Home and Model Designer are on the left, the Simulator is in the middle, the Button
Properties window is in the upper right and the Macro window is in the lower right.

You can always get back to the default layout by using the “Default Layout” button in the “Window” tab.

CCuussttoommiizziinngg tthhee WWoorrkkssppaaccee



AAllll WWiinnddoowwss iinn tthhee DDeeffaauulltt LLaayyoouutt ccaann bbee rreessiizzeedd  
To resize a window, move the mouse cursor to the side, top or bottom edge of the window.When you’re in the right
place, the windows “Resize Window” icon will appear. Next, hold down the “Left Click” button on your mouse and
drag the edge to make the window larger or smaller.

AAllll WWiinnddoowwss iinn tthhee DDeeffaauulltt LLAAyyoouutt ccaann bbee MMoovveedd AArroouunndd  

To move a window to a new location, move the mouse cursor to the title bar of the window, hold down the “Left
Click” button on the mouse and drag the window to a new location.
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CCuussttoommiizziinngg tthhee WWoorrkkssppaaccee



If you grab a window and drag it around the main layout, several new windows “Grouping/Placement Options”
appear. In the example below. I have moved the “Button Properties” window away from its default position on the
left side of the screen.Windows placement icons appear at the top, bottom, left and right side of the main window,
along with a windows grouping icon for the Macro window.

If you move the “Button Properties” window to the middle of the screen, you’ll see a windows grouping icon for the
middle section of the screen.

If you move the “Button Properties” window to the right side of the screen, into the Model Designer window, you’ll
see a windows grouping icon for the Model Designer window.
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CCuussttoommiizziinngg tthhee WWoorrkkssppaaccee

Move the “Button Properties” window
into the middle of the screen 



WWiinnddoowwss GGrroouuppiinngg //PPllaacceemmeenntt IIccoonn 

Windows snap into place when you drag the cursor / title bar of the window you want to move, into one of the five
options in the Windows Grouping Placement Icon.

In the example to the right, the “Button Properties” win-
dow is being dragged into the “Place Above Existing
Window” icon on the left side of the screen.This will place
the Button Properties window above the Macro window.

NNoottee:: The yellow shaded area shows you where the new
window will appear, relatve to the existing window.
In this example, it will appear above the Macro window.

1100 TTyyppee iinn SSeeccttiioonn TTiittllee

U
S
I
N
G

C
C
P

T
O

P
R
O
G
R
A
M

CCuussttoommiizziinngg tthhee WWoorrkkssppaaccee

Place the new window above the existing window

Place the new window below the existing window

Place the new window to the left
of the existing window

Place the new window to the
right of the existing window

Place new window into the
tabbed window grouping

Move the “Button Properties” window into 
the House Designer Tree



UUssiinngg tthhee WWiinnddooww AAuuttoo--HHiiddee FFeeaattuurreess 

CCP has another layout feature that allows you to Float, Dock, Automatically Hide or Permanently Hide a window.

Right click on the down  arrow in the window title bar, a drop down menu appears with the following choices:
Floating, Dockable,Auto-Hide and Hide.

FFllooaattiinngg:: Allows the window to float anywhere on your conputers screen. It’s no longer confined to the CCP applica-
tion window.
DDoocckkaabbllee:: Allows the window to snap to a location (Top , Bottom. Right side, Left side) within the confines of the
CCP application window.
AAuuttoo--HHiiddee:: Automatically hides the window to a toolbar at the Top, Bottm, Right side or Left side of the screen,
depending where the window is docked and provides a tab to access the window.The windows “Pin” icon in the title
bar is turned sideways conveying that the window is “No longer Pinned” in place.
HHiiddee:: Removes/ hides the window from the CCP apllication window.To restore the window, you must go into the
main toolbar and select the window from either the “View” tab or the “Tools” tab.

CCuussttoommiizziinngg tthhee WWoorrkkssppaaccee

The Properties window “docked”. The Properties window “hidden”.

Property window tab created when
this window has been set to “Auto-
Hide”.  To open the window, sim-
ply hover your mouse over the tab.
The window remains open until the
mouse is removed from it, then the
window auto-hides.
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Programming Tips

MMoovvee LLeefftt ttoo RRiigghhtt oonn tthhee PPrrooggrraamm MMeennuu 

The Program Menu is your lifeline to a fast, easy programming experience. Follow the steps in the order shown in the
Menu for best results. Download and Test has been added to the Program toolbar.Typically, you will download to the
remote control several times throughout the programming process to test what you have done so far .You’ll also
need to download once you’ve completed all your final programming.

It is important to complete all of the tasks for each program step, before moving on to the next step, rather than
jumping back and forth and all over the place.

SSaavvee aa DDeevviiccee  ffiillee aanndd IImmppoorrtt ffoorr ffaasstteerr pprrooggrraammmmiinngg  

Archive and save your customized device files. Programming systems with similar components gets even faster when
you don’t have to redo your work over and over. You have your own ideas about how buttons should be labeled and
about how they should be arranged. You can save your work in a unique and time saving way if you save the cus-
tomized device as a stand alone device file which you can import into any new configuration.

PPrrooggrraammmmiinngg TTiippss



CCrreeaattiinngg aa NNeeww SSyysstteemm FFiillee 

OOppttiioonnss -- NNeeww oorr EExxiissttiinngg FFiilleess 

NEW - To start a new job from scratch, click on the “URC logo” and then choose “New” from the File
Menu. A Default file is created: One Room (Home Theater) and one MX-6000 Remote Control

OPEN - Allows you to open a configuration that you have worked on before and saved onto the PC hard
drive.

RECENT DOCUMENTS - The last four files you created in the CCP appear in a list to the right of the File
Menu.You can open oneof the files by double-clicking on it to resume working on the configuration or to
download the file to a MX-6000 remote control.

UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save the
file to your laptop and make any edits or changes the client requested or the jobsite required.

NNeeww FFiillee -- SStteepp bbyy SStteepp

11 Click on the File menu tab and select “New” in the toolbar.

22 The “New File” window appears: Select “Default”, then select 
MX-980 from the list box, finally click “OK”.

CCP creates a new file with one room called “Home Theater” and one MX-980 remote control.
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CCrreeaattiinngg aa NNeeww SSyysstteemm FFiillee



33 Click on the “Configure Home” icon to add rooms or a Base Station(s) to the Home Theater.

The “System Configuration” window appears: Drag and drop a MRF-350 Base Station into the room called “Home
Theater” in the Configuration Tree at the left. If you need to add more rooms

44 Click on the “Properties” button, at the bottom left of the Configuration Tree, then set the MRF-350 Base
Station properties.
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The Base Station Model Properties window appears.

55 Select an RF ID from the RF ID drop-down list.

66 Name the Base Station.

Example:“Home Theater MRF-350”.

77 In the box to the right of each Flasher Port, enter
the name of the piece of gear that the flasher will
be controlling .

Example: Port 1  -  AV Receiver

88 Click “OK” 

99 Close the System Configuration window by 
clicking on the “Close” icon in the upper
right hand corner of the window.

1100 Save the File. In the main toolbar, select  “File”  and then click on  “Save As”.

1111 The “Save As” window appears. Enter a name for the new File, Example: “Smith Residence rev1” and then
click on the “Save” button.
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New Features for MX-980 in CCP

Undo via Control Z  

CCP offers the UNDO feature, particularly useful when you are arranging artwork. Before beginning a large
amount of experimentation, click on save or save as. CCP will track all changes between saves or downloads
unless your PC runs out of memory (that’s probably too much experimentation between saves!).

You’ll find Undo in the EDIT Menu, or you can use the keyboard shortcut Control Z.

Function View for Macro Programming  

You can really speed up macro programming for repeated Activity Macros or Favorite Channels that utilize the
same devices over and over again. Simply choose Function View from the View Menu then click on the
devices you use over and over again (i.e. AV Receiver and Flat Panel TV), then arrange them around your
screen so that you can see the commands you’ll need.
Then start recording your macro. Instead of constantly going to tree view or the simulator to select the devices,
you simply click on the command you need.

16 New Features for MX-980 in CCP
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New Features for MX-980 in CCP

The Create and Name Devices Window  

The new Create and Name Devices window is opened via the Program Menu and click-
ing on the icon on the left. Always work from left to righ in the Program Menu.

The key feature you’ll use is the library of Left, Wide or Right buttons on the left. Simply select the name of the
icon you like and drag it to the page displayed on the right from the alphabetical list. 

The Create & Edit Layouts Window  

The new Create & Edit Layouts window is opened via the Program Menu
and clicking on step two.

After selecting either the Watch or Listen tree, you select the Device in the
template that needs pages added or overwritten, select the new template,
then select the button layout you want. You complete the process by clicking on Add Pages to add a new lay-
out of many pages to an empty device or Overwrite pages to overwrite existing layouts.
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OpenArchitecture and Color 

The MX-980 adds color to your arsenal of tools to make using an Audio Video system intuitive and entertain-
ing to the client. CCP’s MX-980 Editor is engineered to give you immediate access to view and analyze a cus-
tomers system, plus give you the structure to efficiently create a new configuration to add a new feature to the
client’s system.

Left, Right and Wide Artwork Points to the LCD Button  

To encourage the client to press the button not the screen, all the 
artwork for the LCD buttons points to the button. 

Built in features of the editor aid you in placing button artwork specifi-
cally for the left side of the screen or for the right side of the screen.

Additionally, for important features you’d like to emphasize to your
client, you have the option of “Wide” buttons that are operated by
either the left or the right button.

Templates with Built-In Programmer Conveniences:  

MX-980 Editor installs with two templates included. Alpha has very
attractive icons and different backgrounds on every page. However, if
you would like to build a very large file with a few dozen or more
devices, the graphics limit maximum file size. Thus, there is a Text
Only template for large files.

If you would like additional templates, download the Extended Graphics set.

1 Each template is available in a starting configuration 
with Default (1 Room, 1 Remote), Empty (No Rooms, No Remotes), 
and Open existing file as a template. You canstart by creating your 
system from scratch or by deleting devices from a larger file.

2 Additional templates can be downloaded from URC’s installer-only 
website (www.urccontrolroom.com) in the form of a self-installing 
Extended Graphics set, which automatically installs more templates 
in the default location:

C:\Program Files\Universal Remote Control, Inc\Complete Control Program\MX-980 folder.

3 Each template includes an animated and customiz-
able Please Wait screen for macros that take time. Simply program a jump to the Please Wait screen
at the beginning of the macro and a jump to the actual destination page at the end of the macro.

4 Macros are pre-programmed in each Favorite Channel Button in the
templates, enabling you to program favorite channels very conve-
niently using the Alias window. Just double click on the Alias step, then click once on the correct
digit. 

Animated Timer Rotates While Macro Runs

Message is completely customizable
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CCP’s MX-980 Editor Window 

Menus and Shortcut buttons for common tasks.  The Program Menu activates each task in the correct order.

Home Designer and Model Designer Tree Views of the MX-980 configuration.  Double clicking on any
page enables you to quickly display that page on the simulator view. Right clicking on a device or page
activates a context menu.

The MX-980 Simulate View is used to navigate and to select a button to program, edit or record a macro.
Page View enables you to re-arrange buttons on a page and to view the graphics life size. 

Multi-tabbed Tool Window allows access to the “IR Navigator”, “Button, Page and Device Properties”,
“Image Gallery”, “Sound Gallery” and “Serial Database”.

The tabs select whether you want Properties or one of the tools displayed in the window above. 

The Macro window is used to view and edit macros. 

The important thing to remember as you program is that most Windows conventions hold true in all
URC Editors. Explore the program menus. Hover your mouse over most of the buttons and controls
and a balloon will appear with a hint as to purpose. Navigate around the program window and
explore a little before you begin programming.

CCP MX-980 Window

A

B C

A

B

C

D

E

F

Model 
Designer

Simulate & Page View Work
Area Macro

Window

Properties/
Tool

Window
Select via
Tabs (E)

D

Main Menu and
Toolbar

Home 
Designer

E

F
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Programming Overview

A.  New File, Existing File on PC or in Remote  

NEW - Starting from scratch on a new job, go to the File Menu, choose New from the File Menu and
pick either the default file or a blank file. The default template is pre-programmed with IR commands
and is useful for quick testing, but everything will have to be reprogrammed for your system. A blank
file is completely empty. It is really personal preference which way you start.
OPEN - Open a configuration that you have worked on before and saved onto the PC hard drive. 
UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save
the file on your laptop, make any edits or changes as the client requests or the jobsite requires.

B.  Use SAVE AS   

The templates files are simply configuration files that have been preprogrammed for you.  They will keep any
changes you make. Utilize Save As to make a new file with a new file name.  All configuration files are saved
with the file extension .mxa.

TIP — Always use File | Save As to rename the file before doing any programming!  
Use the customer’s name and a rev # (i.e. SmithTheaterRev1.mxa)

C.  Use the Program Menu 

The Program Menu is your lifeline to a fast, easy pro-
gramming experience. Follow the steps left to right as
shown in the Menu for best results. Typically, you will
download to the remote control several times throughout this process and test what you have done so far.
You’ll need to download after finishing all programming. For macro playback to work, you need to have down-
loaded.  These downloads are not listed in the steps here in the Program Menu and are not automatically done
for you.

D.  Edit Button Layouts using Page View and NEW Keyboard Shortcuts  

Moving buttons requires care, because MX-980 artwork is always either Left facing, Right facing or Wide (link-
ing two buttons together). The best way to move buttons around is in Page View (selected from the View
Menu). Double click on each page you want to re-arrange, then drag the pages so that you can view all of
them. Now, utilize the keyboard shortcuts to re-arrange buttons by SWAPPING them:

1 Both buttons are on the same page and the same side. Simply drag either button to the position of
the other button. If they are on different pages but the same side, hold down the ALT key and drag
either button ot the position of the other button.

2 Both buttons are on the same page but on opposite sides. Hold down the SHIFT key and drag either
button to the position of the other button. If they are on different pages and on opposite sides, hold
down both the ALT and the SHIFT keys and drag either button to the position of the other button.

E.  Save and Reuse Customer Files via Import Devices  

Archive and save your customer files. Programming systems with similar components gets even faster when
you don’t have to redo your work over and over.  You have your own ideas about what buttons should be
labeled and how they should be arranged.  You’ll save all of your work and reuse it on the next job with simi-
lar components and devices by using the Import Devices feature.

Programming Overview
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Creating, Naming and Arranging Devices

A device is the basic grouping of a set of hard buttons and as many LCD button pages as the MX-980’s memo-
ry allows.  You will need one device group for each remote control that the MX-980 is replacing.  When you
create devices in the Create and Name Devices window, every device is automatically linked with a jump-link
to the device via either the WATCH or the LISTEN menu. If you create devices manually in tree view (by right
clicking either Watch or Listen and selecting Add New Device) you have to create a jump link from either the
WATCH or the LISTEN menu button to each device manually.

Create and Name Devices Window  

You can open the Create and Name Devices window by
clicking on the first item of the Program Menu:

1 Step 1, after the Create and Name 
devices window appears, select 
the WATCH or the LISTEN menu 
from the Target list box.

2 Step 2, select the theme you’d like to use from
the list box showing all themes installed. 

3 Now, take a look at the page to the left. Where are you going to put the Device Icon? You must
choose from three separate icon styles, the LEFT side buttons, the RIGHT side buttons or the WIDE
style buttons. Click on the icon style you need for this button position.

4 Use Step 3’s alphabetical list to 
find the icon you want. Drag
from the alphabetical list to the
page on the left.

Use the keys on your keyboard
to go to the icon you need (i.e.
click on H to see the HDTV icon.

5 You must hit the SAVE button 
to create all the new devices.

Creating, Naming and Arranging Devices
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Create Button Layouts for Devices and Activities

The Button Layouts window enables you to quickly create new device layouts using any of the twelve tem-
plates. Each device type (i..e. TV, DVD etc.) has an exact equivalent in each template, so you can freely experi-
ment with different template designs before you program or create your own custom labels. 

Caution! You will lose any custom labeling if you Overwrite a device. Do your custom labeling after you’ve
decided on a template.

1 Create devices first -  before you try to Add or Overwrite Pages. Devices must exist as a placeholder
for pages of button layouts. See Page 5 for information on Creating Devices.

2 Empty Devices or Fully Programmed Devices - The ADD function will add an entire button layout,
with many pages to an Empty Device. The Overwrite function will change a button layout for a
device from one template to another. See Advanced graphics for instructions on creating templates of
your own that utilize the Overwrite function on Page XX.

Using the Create & Edit Layouts Window  

1 Open the Create & Edit Layouts Window - Access the Create & Edit
Layouts window by selecting Step #2 from the Program Menu.

2 Select the Device and the Template - Work from Left to Right. Start by selecting the Watch or Listen
group of devices, then select the device in your configuration, then select the theme.

Creating Button Layouts for Devices and Activities

The preview window will
display the selected
device’s existing pages
and the existing tem-
plate, untill you choose a
new button layout. Once
you’ve selected a new
button layout, you’ll be
able to preview it.

However, if the existing
device does NOT have
any pages (an empty
device), you will not be
able to preview the new
template until you have
ADDED the pages.
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3 Select the matching type of Button Layout - Select the device category that is closest to your needs.
If the device has pages, you will be able to preview the new artwork in the preview window before
clicking on Overwrite. However, if your device is empty, you can only see the new artwork if you
click on the Add button. 

4 Click on Add Pages or Overwrite Pages - Click on Add pages if you have an empty device or if you
would like to add pages to the existing pages in the device. Click on Overwrite if you would like the
existing pages updated to the new style of template.

Creating Button Layouts for Devices and Activities
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Utilizing the IR Database

Applying a “Set” of IR Commands to each Device  

1 Open the Database Window - Select IR Database from the Program Menu.

2 Device - In the first list box, MX-980 Editor lists the names of the devices you’ve created and named
in your configuration. Select the device you would like to program from the list box.

2 IR Data From - Select the type or category of component (i.e. TV,  VCR or DVD player) via the “IR
Data From” listbox.

3 Brand - Select the company that made the component (i.e. B & K, Sony, Krell) by clicking on the
correct brand name in the scrollable Brand window.

Using the IR Database
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Using the IR Database

4 Model - Select the exact model number from the scrollable Model window.

If the MODEL number isn’t there, DON’T test the other model numbers! Instead...  
Scroll to the bottom of the list of model numbers for your brand. There you will find a number of “Inclusive”
Code Sets. These code sets are always labeled BRAND1, BRAND2 (i.e.. Motorola1, Motorola2). Each will
operate many different model numbers. Generally speaking, if your component is a recent model, test the
higher numbered Inclusive code sets first. Here’s what the inclusive code sets look like:

5 Test the Code Set
A. Verify the MX-980 is charged and connect it to the PC via the USB port.
B. Point the connected MX-980 so that it is in range and within line of sight of the component.
C. Power On the component.
D. Select the model number or the Inclusive Code set in the model window.
E. Click on the Test button as shown above. The only code you can test is the Power command.
F. If the component DOESN’T power off, try the next Inclusive code set.

6 Once the component powers off, click on the Save button. 

TIP - If you’d like to drag one code to a button or test one code, use the IR Navigator, page 11.  
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Using the IR Database

7 Continue with the rest of the devices you need by clicking on the NEXT DEVICE button and repeat-
ing steps two through eight.

8 When you have finished all of your devices, click on the NEXT button.
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Finding Discrete Commands for Reliable Macros

Discrete Commands versus Toggle Commands
When a remote control’s only button to turn on and off a TV set is labeled Power, it is usually a “toggle” com-
mand. Test it by pressing the button twice. If the power button turns on the TV, then turns it off, it is a toggle
command. You cannot predict whether the component will power on or not. That is a big problem when you
are programming macros! Basically, your client will feel that the macro only works half the time, and will
probably blame you for the problem.

Discrete means that the function of the command is “separate and distinct” from any other function. On a
remote control with “discrete” power commands, there are two power buttons. One that only turns the com-
ponent on, and another that only turns the component off. 

The most commonly sought “discrete” commands are for power on, power off and for TV and Surround Sound
Receiver INPUT selection. These discrete commands will make your macros work every time for your cus-
tomer. 

“Secret” Discrete Codes exist for some components. Why are they secret? Because the manufacturer
wants the remote control that accompanies the component to have the simplest appearance (fewest buttons).
Since toggles reduce the number of buttons, they make the remote control appear easier to operate. Many
manufacturers understand the needs of custom installers and build their components to also respond to dis-
crete codes.  They distribute the discrete codes via service remotes, etc. For the first time, those codes are col-
lected and integrated into our database.

Not all components respond to the discrete codes in the Database.  A component has to be BUILT to
respond to discrete codes. The fact that other models from the same manufacturer do respond to discrete codes
is the reason the codes are added to a code set. However, some models will not respond, because the manu-
facturer did not build it to respond through budgetary considerations, time constraints or a simple oversight. 

Use the IR Database Navigator to Find Discrete Commands  

1 Click on the TOOLS menu then click on the IR Database Navigator.

Finding Discrete Commands for Reliable Macros
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2 Select the IR DATA FROM (category of component), then the BRAND, then 
the MODEL. If you do not see the model number, utilize the INCLUSIVE
CODE SETS (i.e BRAND1, BRAND2, etc). Once you see a command that 
has a promising sounding name, click  on it so that it is highlighted (selected),
then click on the TEST button. You can test any IR command in the list.

3 When you find a command that you want, simply click and drag it to the 
button on the page or the simulator view.

4 After you’ve dragged it to its new position, the new label and a pre-programmed code flag (the
orange P) is placed on the button.

Finding Discrete Commands for Reliable Macros
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TIP - Vary the number of REPEATS to sustain an IR command for a few seconds.  
Many projectors require a two or three second burst to power on or off. You can program this to occur
without the customer having to press and hold the button for several seconds by utilizing the repeat
window in IR Database Navigator. Simply experiment with different numbers of repeats and test the
command until it works as you want it to. There is no predictable relationship between the number of
repeats and seconds from one brand to another, so start experimenting with 10 repeats and time the
burst. Once you’ve programmed a button with this extended IR command, you can use it in a macro.

The timed burst will occur as a single
macro step.

Use the Universal Browser to find Discrete IR Commands  

Using the Universal Browser Window you can import LEARNED IR codes from a .ccf file, an .mxf file or an
.rcc file.  You cannot import any kind of Database codes, only LEARNED codes. 

On the internet, you can find many unusual discrete codes by browsing the files section of a website popular
with other custom installers:

www.remotecentral.com
You can often find discrete codes by posting at one of many other sites popular with custom installers by post-
ing on an online bulletin board. If any other custom installer knows of a solution he/she will email a file to
you.  Whether your download a file or if you are emailed a file from another installer, the Universal Browser
enables you to import learned codes into your MX-980 configuration.

After you’ve saved the file to your PC, you use the Universal Browser as follows:

1 Open the Universal
Browser by clicking
on the Universal
Browser icon in the
TOOLS menu.

2 Click on the File icon to navigate to the folder that contains the file you’d like to get codes from.

Finding Discrete Commands for Reliable Macros
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3 Use Tree View to Navigate to the Panel containing commands you want. Click on the panel name in
Tree View to make the panel appear in Panel  View.

4 Click on a button in Panel View and the Action List view will reveal whether it has a Trigger code
(MSC-400), Learned code or Pre-Programmed Data. 

5 Click and drag the button to the MX-980 simulator.

6 After you’ve dragged a command from the browser, the button will change
it’s name if it is a screen button. Both screen and hard buttons show the
appropriate flag (Trigger, Learned or Pre-Programmed)
after you’ve dragged to a button. 

Finding Discrete Commands for Reliable Macros

T - Trigger - Indicates an MSC Trigger Command
L - Learned - Indicates a Learned IR Command
P- Pre-Programmed - Indicates an IR command from
the URC database.
M - Macro - Indicates a macro is programmed.
PT - Punch Through - Indicates that the button is
“punched through” to another device.
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Test All Commands and Relabel for Easy Operation using ALT and SHIFT   

MX-980 Editor Page View enables you to display multiple pages and drag and drop buttons from one
page to another. However, since the artwork for buttons on the right points to the right and art for the
left points to the left, you must use the correct keyboard shortcut (Hold down ALT and SHIFT) to drag
from one position to another.

Before programming any further, you should rigorously test all of the codes you have programmed
using the IR Database and label the buttons with names that the customer will find easy to under-
stand. The best approach is to download, test all the commands, and as you test, use MX-980 Editor
to modify labels, and hide or delete unnecessary commands.

Download and Test While Arranging Buttons  

Begin testing the codes you downloaded to the MX-980. Make sure that you test all buttons (hard
buttons and the LCD buttons on each page of every device). Don’t try to learn new commands yet,
wait until you can do all of them at once systematically. First you must delete commands that don’t
work and change the labeling so that your client instantly understands why you’ve made the button
available to them. Good practice is to simply delete commands that the client will never use, or to
arrange them on the last pages of a device. Certainly, your most important goal is to place the most
useful commands on the first page of a device, so that the client has everything they need without
pressing a PAGE button.

Using Page View to Relabel and Re-arrange Buttons 

1 From the View Menu, select Page View Mode.

2 In Tree View, expand the device you would like to EDIT. In Tree View Double Click on each page of
the device to display them. You can have as many pages open as your screen size makes usable.

Test All Commands and Relabel for Easy Operation
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Tip - After you’ve opened all the pages you want to edit, drag them into the positions you like. 
Use the Window Menu to control the open page windows as follows:  

3 Arrange Buttons by Holding Down ALT and SHIFT then Drag and Swap Button Actions and Labels
without Swapping Art!!!
Your client will be much happier with pages that look consistent. If you simply drag a button to
swap to another, everything swaps, including the left or right facing artwork. If both buttons have
exactly the same art that’s great. Much of the time, however, the art is slightly different in each place.
So you need to be able to swap a button’s label and action list (which includes the IR command or
macro you’ve programmed on the button). The SHIFT button lets you do that. The ALT button lets
you swap buttons from one page to another. Here’s a recap:

No Keys Held Down - Dragging and dropping over another button only works on the same page.
Everything is swapped: the art, the label and the action list. Only useful if
swapping one left button for another left button or one right button to another
right button.

ALT Key Held Down - Page to page dragging and dropping. Everything is swapped: the art, the label
and the action list. Only useful if swapping one left button for another left
button or one right button to another right button.

SHIFT Key Held Down - Dragging and dropping over another button only works on the same page.
Only the label and the action list are swapped. 

ALT and SHIFT Key Held Down - Dragging and dropping over another button works page to page.
Only the label and the action list are swapped. 

4 Label Buttons as needed - First, select the button

The text controls enable you to type in multiple lines and space the text relative to the button art,
using the vertical/horizontal alignment tools. However, for the best appearance, it is often necessary
to use the SPACE bar before a word. 

TIP - To move a text label away from a button edge, click before the word and use the SPACE bar.  

Test All Commands and Relabel for Easy Operation

Cascade - Arranges all open pages in the most
compact stack (best for small screens)
Arrange Icons - Minimizes all open pages
Close - Closes the selected page
Close All - Closes all page views.

Second, type into the 
Normal Text window.
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5 Repeat Steps 2-4 and continue to test all commands for all of your devices by double clicking in
Tree View, then editing the pages as needed. If you are missing a command and need to learn it,
delete any buttons that you don’t need and relabel to prepare for learning. 

Tip - Move important commands to the first page of the device/activity. 

Hiding Pages in Page View  

A hidden page is accessible during programming so you can teach commands to buttons on hidden
pages and use them in macros. The interesting thing about hidden pages is that the end user cannot
manually access the page using the PAGE button. You HIDE pages by right clicking on a device in
Tree View, then selecting Hide from the context menu that appears.

After you’ve hidden a page, the page is greyed out in Tree View.

Page 1 is Not Hidden

Page 2 is Hidden

Page 3 is Not Hidden, but it is about to be changed to Hidden (menu
is revealed when you right click on a page) by clicking on Hide in
the context menu.

Test All Commands and Relabel for Easy Operation
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Learning

Learning should be a last resort for professional installers. We make every effort to provide you with
any codes you need via our database. If they are not, please make a note to email us at the first
chance with the learned file you created, the type of device it is and the Brand and Model Number. If
it is not a current model component, we would still like to add it to the database, but please note in
your email the approximate age of the component. Please address your emails to:

IRDatabase@universalremote.com

Tips for Learning from Unusual Devices  

When you have difficulty successfully teaching codes to the MX-980, always try these tips in the order below:

1. Fresh Batteries in the Original Remote Control - Weak batteries will cause MX-980 Editor
to fail to correctly learn.  Note that EVEN if the original remote still operates the component,
the batteries can be too weak to produce a strong enough carrier for any learning remote con-
trol to detect!!!! When a code fails, replace the batteries FIRST!

2.  Tap instead of Pressing and Holding - With buttons that the client will only tap when using,
this may produce better results. Normally, you should press and hold. 

OR

2. The “Flutter” Technique - If you are having problems with a Code that has to be sustained
(like volume up or down), sometimes fluttering the button on the original remote at least seven
times while you are learning will successfully teach the code.  

3. Vary the Distance between the Remote and the Learning Sensor - We recommend that you
start with a distance of half an inch between them. If no other technique works, try varying the
distance by doubling it each attempt. Keep trying until you are at least 5 feet away.

4. Try Standalone Learning, see page 23.

5. Call our technical support department at 1-800-901-0800 to see if they have a cross refer-
ence for the brand and model you are using. If there isn’t a cross reference, they will ask
you to ship the remote to our engineers so the codes can be added to the database.

Learning IR Codes One at a Time  

When all you need is a code or two, this is the method to use. If you need to teach an entire set of codes from
a remote control, skip to the Batch Learning section on page xx.

1 Connect the MX-980 to your PC and verify that the ActiveSync icon in the lower right hand corner
of your PC screen is green.

Learning
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2 Select the button that you want to teach to by single clicking it on the simulator.

3 Click on the LEARN Tab or choose Learn from the Program. There will be a pause, while the PC
communicates with the MX-980, then the info window will display “Ready”.

4 Press and hold the corresponding button on the original remote control while pointing it at the top
of the MX-980 (head to head) with the remotes approximately a half inch to an inch apart. When the
code is successfully learned, the window will say GOOD, confirming that the code learned “correct-
ly.”  Actually, the GOOD means that the code might be good.... You need to test it. Select the code
in the Current Learned IR List, then click on the TEST button while pointing the MX-980 at the
device.

TIP - Always POWER OFF the RF Base Station when testing Learned Codes. Test line-of-sight only!
If there is any interference or IR saturation, your tests will fail, not because of learning issues but
because of RF setup issues. Don’t waste time, test your codes now, test RF setup later. 

Learning

The Learn Button re-activates
the Learning process when it
automatically times out or if
you want to re-learn a com-
mand.

The Learning Information
window prompts you when
the system is Ready to learn
a new command and when
a learned command is
Good, or if it Fails.
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Learning

5 If the code doesn’t operate the component you can try the DoubleTap learning method. This is par-
ticularly useful for components using the Philips RC5 ‘togglebit” protocol.  Many high end audio
companies use these codes. Just click on the 2 Time Learn radio button and you will be prompted to
learn every code twice.

6 Click on SAVE - You must click on SAVE to save the LEARNED command. The blue “L” learned flag
appears on the button you taught the command to.

Learning a Batch of Buttons Quickly  

Using this method, MX-980 software will automatically save and select the next button, saving lots of time
when you are learning an entire remote control. Key to your success are two tips:

Tip #1 - Always label all your buttons before beginning  

Tip #2 - Verify with one button that the codes from the new remote learn normally.  

Once you’ve prepared, batch learning goes very quickly:

1 Select the STARTING Button - Select the button that is the top left of the buttons you want to teach
to.  When MX-980 Editor automatically saves and selects the next button it moves left to right, unless
it is learning a group of buttons with similar functions. When you are batch learning the Volume
Group, MX-980 Editor first learns Volume Up, then Volume Down, then Mute, then advances to the
next group. 

2 Select  both the LEARN and the CONTINUE button - The combination activates the batch learning
capability of MXEditor. It is normal for MX-980 Editor to time out after learning the LCD page, and
again after learning the hard buttons. The CONTINUE button remains selected, but you must restart
the batch learning by selecting a new starting button on another LCD page or device, then selecting
LEARN again.
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3 Watch the LEARNING Window - When the info window says READY, press and hold the button on
the original remote control. When it says GOOD, release the button. If it says FAIL, reteach the same
command.  When you see that a new button has been selected and the LEARNING window says
READY, then teach the new command from the original remote control.  

Tip - To skip a buttons in the automatic sequence, select the next button you want.  

Tip - You can test any code by selecting it on the simulator and clicking on the TEST button. 

4 Remember to save your work, go to the File menu and select SAVE. 

Learning



Advanced IR Code Manipulation

After learning of IR codes is complete, it’s time to download to the remote control and test all the learned codes.
Test, test, test ....Then you know it works, or not. If a code isn’t working one hundred percent of the time you can
either re-learn it or try to manipulate the IR code to get it to work.

TToo eenntteerr ““AAddvvaanncceedd IIRR SSeettttiinnggss”” sseelleecctt aa bbuuttttoonn oonn aa ppaaggee aanndd tthheenn ddoouubbllee--cclliicckk oonn tthhee IIRR ccooddee iinn tthhee ““MMaaccrroo”” wwiinn--
ddooww..

AAddjjuussttiinngg tthhee ““MMiinniimmuumm RReeppeeaatt WWhheenn PPrreesssseedd”” sseettttiinngg 

MMiinniimmuumm RReeppeeaatt WWhheenn PPrreesssseedd:: NNoo mmaatttteerr hhooww qquuiicckk aa bbuuttttoonn iiss pprreesssseedd iitt wwiillll oouuttppuutt  ““33”” rreeppeeaattss aatt aa mmiinniimmuumm..
If you psychically press and hold the button, it will output commands until the button is released.“3” is the standard
repeat value for our remotes. If you are getting double commands for an IR code, ( “22” instead of  “2”), lower the
repeat value to “2”  which will resolve this issue. Normally you would not go higher.
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Double-click the IR code
in the Macro window



CCrreeaattiinngg aa SSuussttaaiinneedd IIRR CCoommmmaanndd iinn aa MMaaccrroo -- AAddjjuussttiinngg tthhee ““RReeppeeaatt”” 

Unchecking the “Repeat while button is pressed” box opens up the “Repeat” adjustment setting.

TThhee ““RReeppeeaatt”” aaddjjuussttmmeenntt sseettttiinngg wwiillll oonnllyy oouuttppuutt tthhee ssppeecciiffiieedd nnuummbbeerr ooff rreeppeeaattss lliisstteedd iinn tthhee bbooxx nnoo mmaatttteerr hhooww
lloonngg tthhee bbuuttttoonn iiss pprreesssseedd ffoorr.. This feature can be used with a component like a Projector, that need “2 seconds” of
continous IR output to turn on or off. You would uncheck the “Repeat while button is pressed” box and set the
“Projector On button” to repeat.Typically, most IR commands are about 7-15 repeats in one second.You’ll have to
experiment to find how many repeats equal how many seconds with each new component you try this with.
When the button is pressed, this macro step will output a string of 20 repeats and reliably turn on/off the projector.
Essentially, you are creating sustained burst (as if you were Pressing & Holding the Projector On button)  when you
this advanced IR code manipulation feature.

TTeessttiinngg IIRR CCooddeess aafftteerr cchhaannggiinngg tthhee RReeppeeaattss 

WWhheenn yyoouu ssttaarrtt cchhaannggiinngg IIRR RReeppeeaattss,, yyoouu mmuusstt tteesstt ttoo sseeee iiff yyoouu’’vvee rreessoollvveedd tthhee pprroobblleemm oorr mmaaddee iitt wwoorrssee.. 
Connect the MX-6000 to your computer, via the USB cable and click on the “Test” button to test the new IR code.
Experimentation will teach you what works best for different problem components. Make shure you add problem
compnents like projectors to your “Device Library”, so you only have to go through this process one time.
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Macro Programming

Bullet Proof Macros or Point N Pray?  

Professional Installations Require “Bullet-Proof” macros (all discrete codes or workarounds, no toggle
commands). A Point and Pray macro is created when you place a toggle command in the macro (like
a TV Power command). The use of Point & Pray macros that only work if the customer follows strict
rules will create service calls and a lot of bad will (for example, you force the customer to verify that
the system is completely off before using the TURN ON macro). When you cannot find discrete
power commands, create an extra device called “POWER” or “SYSTEMPOWER” and give your client
one place to find all the power commands. Instruct them to power on their system manually from this
easy, convenient page, then return to WATCH or LISTEN to use the automated input switching Macros
for the ACTIVITIES like Watching CABLE, Watching a DVD movie etc. -  For systems with lots of tog-
gle Power codes, create a “Power”

HELP list.  

Finding

Workarounds When There Are NO
Discrete Codes  

By creatively experimenting you may find that you can workaround the lack of discrete codes. This takes time
and there is no guarantee that you will find a workaround for any given component.  Here are some common
examples:

DVD and  VCR Power Workaround
Most DVD players will turn on when off when they receive a Play command. Thus you can workaround like
this:

DVD ON = 1) Play DVD OFF   = 1) Play 
2) DVD Stop 2) A delay of 2 to 4 seconds

3) DVD Power (toggle command)

TV scrolling “INPUT” Workarounds
Many televisions respond to a channel up or a channel number command by changing to the Antenna input
regardless of what input was last selected. This creates an “anchor” action that puts the television in a known
input. Thus you can create a workaround as follows:

EXAMPLE - CH Up takes TV to the ANT A input (and the TV has 5 inputs -Ant A, Ant B, EXT1, EXT2 and EXT3)

Macro Programming

In this example, the program-
mer has created a device called
SYSTEMPOWER. The client has
one convenient page to power
up their system manually. 

Each button is labeled for the
power command the program-
mer has placed via the IR
Database Navigator.

This is much better technique
than programming a Point N
Pray Macro that will result in
much customer frustration.
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Macro Programming

TV to EXT3 = 1) Ch Up (takes TV to ANT A regardless of what input was last selected)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)

Using the Macro Window  

The Macro Window controls macro recording as follows:

Tip - All Buttons Can Be Macros except the Watch, Listen and 
Page buttons.  

Record- Starts the macro recording
process.This enables you to simply navigate
to any page and click on a button to create
an “Alias” to it. An “Alias” is a copy of the
button’s IR command(s).

Test Macro - Play back your
macro by following these steps:

1) Select the first step in the
macro.

2) Connect to an MX-980

3) Click on the TEST button. 

Draggable Macro Steps - In this
window, you can view all of your
macro steps. You can click and
drag any step to any position,
changing the order of the macro.

Delay -  Click to open the
delay window. Any step can
be a delay between .1 and
30 seconds. Longer delays
can be created by using
more than one delay. 

Stop - Click to stop Macro Recording
and save your work.

Delete -  First select the step you want to
delete, then click on this button (or the
Delete key on the keyboard.

MX-980 Only - SET VARIABLE
Opens the Set Variable window,
which enables you to pick an
already-created variable and set it
to 0, 1 or to simply Invert its sta-
tus.

MX-980 Only - Text -  Any step
can make the button label change.
If you want the label to stay
changed, insert a delay after the
text step to keep the text on for
enough time for your client to read
it.

If/Else - This statement enables
you to program a decision into a
macro.  So if your TV is currently
off, turn if on (send a power
command), else do nothing. 
Sleep Timer - Select this option
to choose when to execute a
macro.  The window will display
15 min, 30 min, 60 min, 90 min,
NOW, EXIT or CANCEL. 

Toggle - Toggle Macros are a
way of cycling through multiple
similar functions such as sur-
round modes or favorite chan-
nels while using only one button
on the remote. 

Jump -  As the last step in a
Macro, you can specify a jump
to any page of any device.   You
can program another jump in
the macro to display a page
with a status feedback message
or image.
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Programming a System Power On Macro  

Set up your laptop and the connected remote within operational range of the home theater system
while programming a macro. Macros that the client will use to turn the system on require extensive
testing of delays and you can expect to do a lot of experimenting while programming.

In this example, the WATCH device’s ON button is programmed to turn on the system, configure all
the Inputs and Modes for the client’s favorite activity, watching HDTV Cable TV.

1 In Tree View, navigate to the WATCH device. On the simulator, select the On button.

2 Click on the RECORD icon or select Macro from the Program Menu.

3 In Tree View, expand all the pages of the devices you are
going to power on. Navigate to the first device you’d like to
turn on. Since the Plasma TV in the example system takes sev-
eral seconds to warm up, it is the first device we’ll turn on.
With single clicks on the pages inside the Plasma TV device
we find the P-On command on Page 3.

4 On the simulator, click on the button with the device’s Power On command.

The new step appears in the Macro spread sheet:

Macro Programming
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Macro Programming

5 Program steps to power on the other components in the system. In this example, the cable box is
powered on all the time, since it is a DVR, so the only other component to power on is the surround
sound audio receiver.

6 Program steps to select the correct TV and Receiver input for the client’s favorite activity. In this
example the client’s favored activity is watching Cable TV. The cable box is connected to the TV
input of the Surround Sound receiver and the component output of the cable box is directly con-
nected to the HDTV’s Video 3 input.

7 Program a jump to the Device and Page they use for their favorite activity.
Click on the JUMP icon. 

8 Select the correct device and page from the Jump window. The jump appears in the Macro window
in the column under Jump.

9 Now, test if delays are necessary in your macro. First, turn the TV and the Receiver to the wrong
input, then turn off everything in the theater.  Point the connected MX-980 at the system. Select the

first step in the list by clicking on it. Now, click on the TEST button. Observe the television and
the receiver. Did they both switch to the correct input?

In the example system, the TV requires four seconds of warmup before the Input will correctly
change. The surround sound receiver requires two seconds, so we program a four second delay after
the TV and the Receiver power on.
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Macro Programming

10 Select the Delay icon , then when the delay window opens, click on the preset amount of delay
or enter any time between .1 second and 30 seconds.

11 The new step appears in the list. Now, drag the delay step to the correct location.

TIP - Sometimes a change in order can provide the delay you need. 
Each IR command lasts approximately 1/3 of a second, so if you have 3 commands, one second has
elapsed. 

12 Again, turn the TV and the Receiver to the wrong input, then turn off everything in the theater.  Point
the connected MX-980 at the system. Select the first step in the list by clicking on it. Now, click on
the TEST  button. Observe the television and the receiver. Did they both switch to the correct input?
Continue to revise the macro with delays or changes until the macro ALWAYS correctly turns every-
thing on and switches the surround sound receiver and television to the correct input. When the
macro is perfect, click on the STOP in the Macro Window.

13 Remember to save your work, click on SAVE in the File Menu.
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Programming a Power Off Macro  

A Power Off macro is much simpler than a Power On macro, since there are rarely any delays to test, etc.
Usually, to give the client some feedback that the macro is working, the TV is turned off first.

When you are forced to “workaround” a DVD player or VCR without a discrete off command, you will make
the macro more reliable if you place the time consuming anchor (the play command) at the beginning of the
macro.  Make sure that you turn the DVD player off before testing this kind of workaround.  You are testing the
worst case, you know that a toggle type power command will turn the DVD player off, you are concerned
about an event that might happen. The DVD player is already off, but the client presses the MAIN Power Off to
turn everything else OFF. If you only programmed a toggle Power command, everything else would turn off,
but the DVD player would turn on. This “workaround” ensures that the DVD player turns off.

Finally, so that this macro will work correctly when you set up Punch Through, program a jump to the WATCH
pages. Thus if the user presses OFF after watching a DVD movie, the MX-980 will jump to the WATCH device,
perfect for picking up the remote tomorrow night! 

Copying Macros for Activity Macros  

You can often speed programming by instantly inserting all of the steps of a previously programmed macro as
the starting point of a new macro. The inserted steps are completely editable, without changing the original
macro.

1 First, highlight the button with a Macro and select Copy from the Edit menu. 

2 Then highlight the button without a macro and select Paste from the Edit Menu.

Tip - Copy and Paste Macros  
The keyboard shortcuts for Copy: Control+C, for Paste: Control+V.TThhrreeee UUnniiqquuee MMaaccrroo MMooddeess 

Macro Programming



TThhee MMaaccrroo WWiinnddooww

OOppeenniinngg MMaaccrroo WWiinnddooww 

If the Macro Window is closed, reopen it by selecting “Macro” under the main toolbar View Menu tab.

TThhee MMaaccrroo SStteepp TToooollbbaarr BBuuttttoonnss  

TTEESSTT You must select the first step you want played back first, then connect the remote to the PC.
All steps after the selected step will play back, including any delays.

RREECCOORRDD Starts the macro recording process.This enables you to simply navigate to any page and click
on a button to create an “Alias” to it. An “Alias” is a copy of the button’s IR command(s).

SSTTOOPP Stops the recording of macro steps.

DDEELLEETTEE Deletes the highlighted macro step(s).

IIFF // EELLSSEE Enables you to create a conditional “If __(my Variable is set to X)__  do this, Else_(Do 
this)___” macro.

TTOOGGGGLLEE Enables you to create a list of IR commands that the button “Toggles” through.

DDEELLAAYY Opens the Delay window so that you can specify a delay in between macro steps.

JJUUMMPP TTOO Enables you to jump to any Page of the remote, including a Device Page or Main Page,

TTEEXXTT Opens a Text Window to type in text that will appear on the button as a macro step.
Program a delay at the same time as the text to determine how long the new text will stay
on the button.You can have as many text steps as you like (to the maximum of 255).

VVAARRIIAABBLLEE Opens the Action Variable Setting window, which enables you to pick an already-created variable
and set it to True, False or to simply Invert its status as a macro step. If you want to create a
variable, click on “Add New” at the bottom of the window.

SSLLEEEEPP TTIIMMEERR    Label the button SLEEP TIMER.When the user presses the button, the MX-6000 displays “Go to
Sleep in 90 Minutes”,“Go to Sleep in 60 Minutes”, “Go to Sleep in 30 Minutes”, “Go to Sleep in
15 Minutes”  “Cancel” and “Exit”..Whenever the Sleep Timer runs out, the macro you pro-
grammed will be issued (unless the user hits the cancel button).
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TThhrreeee UUnniiqquuee MMaaccrroo MMooddeess 

There are three unique Macro Modes available; Normal or (True Mode), Press Time Mode and Variable Mode. Every
button has the potential to do two different macros based on either a variable changing, or how long the user press-
es the button. Play with each of the three Macro Modes to get used to them.

SSeettttiinngg tthhee MMaaccrroo MMooddee

To set the “Macro Mode” of a button, click on the button in the simulator and then click on the “IF/ELSE” icon in
the Macro window toolbar. An “IF/ELSE” statement appears in the Macro window, double-click on the IF/ELSE state-
ment to open the “IF Setting” Macro Mode window.

TTrruuee MMooddee  If the “True Mode”radio button is selected, the macro will be issued every time the button is pressed.

The “IF Setting” 
Macro Mode Window 

appears
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PPrreessss TTiimmee MMooddee In the “Press Time Mode”, the button can have two different macros based on the amount of
time the button is held down for. One macro will be issued if the button is pressed “Less
than” (< ) or “Greater than / equal to” ( >= ) the specified time.This is called the ““IIFF
OOppttiioonn””. A different macro will be issued if the button is held down more/less than the spec-
ified time.This is called the ““EELLSSEE 

In this example the “Navigation Down Arrow” has two macros associated with it.
If the button is held down for one second or more (Press TIme >= One Second), the button will issue a ““CCaabbllee PPaaggee
DDoowwnn”” IIRR ccoommmmaanndd, if it is held down, or pressed and released for less then one second, it will issue a ““CCaabbllee DDoowwnn””
IIRR ccoommmmaanndd..

VVaarriiaabbllee MMooddee In “Variable Mode”, the button can have two different macros.A unique macro will be issued if the
button is pressed when the specified variable is ““TTrruuee””. A different macro will be issued if the button
is pressed when the specified variable is ““FFaallssee””.
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In this VVaarriiaabbllee eexxaammppllee, the TV takes fives seconds to warm up before it can receive an IR command to change the
input. I want the “TV Power ON” button to contain the “Variable”, so I only have to enter once, Any time I ““aalliiaass””
(see explanation below) the “TV Power ON” button, the Variable automatically comes with it, so if for some reason I
have to change the delay from five seconds to six seconds, I only have to change it in one macro, not in every macro
that uses the “TV Power ON” button.

NNoottee:: At the end of the macro I’ve added the variable statement: (TV Power ON is now TRUE).
The next time the TV Power On is aliased, it will not wait five seconds because it now knows the TV is already ON.

WWhhaatt iiss aann AAlliiaass??  

AAnn aalliiaass iiss aa mmaaccrroo sstteepp tthhaatt iinn oonnee sstteepp,, ppooiinnttss ttoo aann eennttiirree mmaaccrroo pprrooggrraammmmeedd iinn aannootthheerr bbuuttttoonn.
If only one command is programmed in the other button, then the macro step will only perform that command.
However, if the other button has multiple macro steps, the entire macro will be played back as one step in the new
macro.Thus, the Alias feature not only saves memory (since it is not copying the IR commands, only pointing to
them), but enables you to program macros nested inside other macros. See advanced programming on page XXXX for
some examples

RReeccoorrddiinngg MMaaccrroo SStteeppss 

In the Simulator, click on the button that you want to contain the macro. Click on the “Record” icon in the Macro
window toolbar to start the recording session. Next, click on the buttons you wish to add to the macro;TV Power
On, Receiver Power On,TV input, Receiver Input etc..When the macro is complete, click on the “Stop” icon to end
the recording session.

RReeccoorrddiinngg OOtthheerr TTyyppeess ooff MMaaccrroo SStteeppss  

For any other kind of macro step (other than Aliases), you do not have to click on record. Simply select an IR com-
mand from the IR Navigator or a sound from the Sound Gallery and drag them into the Macro window.

RRee--AArrrraannggiinngg tthhee MMaaccrroo SStteepp OOrrddeerr  

You can drag any macro step to a new position by clicking, holding down the left mouse button and dragging it up or
down the list.

Macro Programming
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Macro Programming

DDeelleettiinngg aa MMaaccrroo SStteepp  

You can delete a macro step by selecting it first, then hitting the “Delete” key on your keyboard or by clicking on the
Delete shortcut icon in the Macro window toolbar.

TTiipp --  YYoouu ccaann rreessiizzee tthhee MMaaccrroo wwiinnddooww bbyy ssiimmppllyy cclliicckkiinngg aanndd ddrraaggggiinngg tthhee ttoopp ooff 

Utilizing Function View to Program Activity Macros or Favorite Channels  

You can really speed up macro programming for repeated Activity Macros or Favorite Channels that utilize the same
devices over and over again. Simply choose Function View from the View Menu then click on the devices you use over
and over again (i.e.AV Receiver and Flat Panel TV), then arrange them around your screen so that you can see the
commands you’ll need.

Then start recording your macro. Instead of constantly going to tree view or the simulator to select the devices, you
simply click on the command you need.
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Using Sounds

Setting the Default Sound  
MX-980 Editor enables any button to have a sound play when the button is pressed. You can set a default
sound for every button throughout the configuration as follows:

1 Click on the View tab and make sure the Properties option is checked.

2 Within the Model Designer, highlight the MX-980 remote.  

3 Click on the Properties tab.

4 Click the checkbox for Use when a button is pressed. 

Using the Sound Gallery  
MX-980 Editor enables you to program any button with as many sounds
as you like. However, for each sound, you must program a delay after
the sound, long enough for the sound to play completely. To use sounds,
click on the Sounds icon in the macro toolbar, or select Sound Gallery
from the Tools Menu. Simply drag a sound into a macro, then place the
optimum delay after each sound.  

Sounds and Images
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Using the Image Gallery  

The MX-980 has a limited ability to use images instead of text. First, make sure you are in Simulator or Page
View mode, then double click on the page you want in Model View. Now, from the tools menu, open the
Image gallery. 

Click on the browse button to select the folder of art you want.

Using the Image Gallery



TIP:  
Download the Graphics Expansion Pack from www.URCControlRoom.com to add all the available
galleries of art to your PC. The expansion pack automatically installs all artwork into CCP.

Drag an image from the gallery to the button you want to replace. Codes and labels remain when you drag
new art into a button.

Editing Image Galleries  

All your installed image galleries
can be viewed and edited via
Windows Explorer (My Computer)
by navigating to this folder:

C:\Program Files\Universal Remote
Control, Inc\Complete Control
Program \MX-980\Images
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C:\Program Files\Universal Remote Control, Inc\Complete Control Program \MX-980\Images



Two Images for each Icon - Pressed and Unpressed...  

CCP interprets the file names of the image files to match up the Normal and Pressed states of each button, and
to determine the ideal text settings for button labels. Therefore, only one image of each device or activity
appears in the Image galleries of CCP, instead of the two corresponding image files that actually occur in the
associated folder on your hard drive.

Speeding up the Create & Name Device Window 

To display the thumbnail images that appear in the Create & Name Devices window, CCP searches the folder
associated with that theme for images that match the file naming convention, then creates a thumbnail image
for each possible button. While this provides an excellent overview of the 50 to 150 sources and activities
available in each theme, it can also slow down your editing. If there are source icons that you know you will
never use, you can eliminate those icons to speed up the Create & Name Devices window.

Instead of deleting the original image files, it's best to make a copy of an existing theme and delete unused
icons from the duplicate version. To make a duplicate of an existing theme, use Windows Explorer to navigate
to C:\Program Files\Universal Remote Control, Inc\Complete Control Program \MX-980\Images\THEME\,
then select the theme you want to speed up. Select the folder, choose File>Copy from the Explorer menu, then
choose File>Paste. 
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Programming Punch Through

Punch Through allows you to set the same functions on all devices very quickly.  You can punch through any
of the groups of buttons on the MX-980. In this exampe, the Power On and Power Off buttons on every page
and every device are set to punch through to the WATCH Power On and Power Off buttons, thus the user can
power off the system without returning to WATCH to press Power Off. Likewise, the Volume Up, Down and
Mute have been set as a group to punch through to the surround sound receiver. After programming, flags
remind the programmer that the buttons have been set to punch through.

1 Open the Punch Through window by selecting Punch Through from the Program Menu.

2 Select the devices which you want to change programming by clicking on them
while holding down the CONTROL key on the keyboard.  If you want them all
selected (normal for Volume Up, Down and Mute), simply click on the Select All
button.  Any device you select will be HIGHLIGHTED in the “Punch To” list.

3 Select the device that has the codes you want used in the Punch From list.

4 Click on SAVE.  Check the devices you programmed, you should see the red PT (Punch Through)
flag on every button affected on all the devices you programmed:

RF Control 



TThhee RRFF CCoonnttrrooll WWiinnddooww
Open the RF Control Window by clicking on the RF icon button on the Program Menu Toolbar (Step 5).

OOvveerrvviieeww ooff BBaassiicc RRFF OOppttiioonnss  

Using the RF Control Window you can modify the RF properties of an MX-6000 as follows:

11 SSiiggnnaallss from the Remote can be set to IR only, RF only or Network (For future use). The factory default is
set to IR.

NNOOTTEE!! TThhiiss mmuusstt bbee sseett ffoorr eeaacchh ddeevviiccee iinnddiivviidduuaallllyy!!  

22 RReecceeiivveerr -- If you have multiple MRF Base Stations in the system, you can select which receiver a device will
be connected to.The factory default is set to Default.

33 IIRR OOuuttppuutt -- You can choose which of the emitter ports a device is connected to.This is vital when your
system includes some identical components using the same IR code set. If you are installing a typical system
with an assortment of unique components using different IR codes, you can leave the Flashers set to the
factory default selection of ALL, however if operation is intermittent try routing to one flasher only.

OOvveerrvviieeww ooff RReecceeiivveerr RRFF OOppttiioonnss  

By clicking on the “Add a Base Station” button at the bottom of the window, you open the “House Designer” win-
dow where you can add a new base station by dragging it into the room name, in the configuration tree.

11 RRFF IIDD -- To prevent all MRF Base Stations from receiving RF commands, you may opt to set a unique ID#
to each.This is useful when identical components are installed in different locations. If your system has an
assortment of unique components using different IR code sets, you may leave the receiver ID # set to the
factory default of ID 1.

22 NNaammee -- Give the MRF Base Station a unique name, like “Home Theater MRF-350”.

33    PPoorrtt IInnffoorrmmaattiioonn -- Name the component connected to each emitter port.
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Set each device’s basic RF properties by click-
ing on the row and column you want.When
you do, a combo box will display the choices
available. Click on the option you want:



TThhee UUnniivveerrssaall BBrroowwsseerr WWiinnddooww
Open the Universal Browser Window by clicking on the Tools tab of the main menu toolbar, then clicking on the
Universal Browser icon.

OOvveerrvviieeww  

Using the Universal Browser Window you can import “Learned IR” codes and “Database codes” from any Universal
remote control file. If you have Pronto .ccf files on your computer, you can import any “Learned IR” codes, but you
cannot import  generated RC5, Database or generated NEC codes.The browser works as follows:

11 Click on the File icon to navigate to the
folder that contains the file.

22 Use Tree View to Navigate to the Panel
containing LEARNED IR codes you want.

33 Click on the panel name in Tree View to 
make the panel appear in Panel  View.

44 Click on a button in Panel View and
the Action List view will reveal whether
it has Learned Data or not. Only buttons
with Learned Data can be transferred.

55 Click and hold the left mouse button
to drag a button with learned data 
to any programmable button on the
MX-6000 in Simulate View Mode.

66 When you release the mouse, the blue
indicating a Learned IR command is

displayed on the simulate view of the
button.
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WWoorrkkiinngg wwiitthh HHeexx CCooddeess

The Universal Browser also allows you to directly enter Pronto Hex Code into the “Hex” window and then drag it
onto a button or into the Macro window of a button. It automatically converts the hex code into an IR code.

1. Clcik on the “Hex” icon In the Universal
Browser toolbar.

2.The “Hex Editor” window appears at the bot-
tom of the Universal Browser.

3. Use Internet Explorer to navigate to
RemoteCentral.com.

4. Navigqate to the “Discrete Infrared
Hex Codes” section, then find the
code you want to copy.

Select “Copy to Clipboard”

5. Paste the code into the Hex window
using the shortcut (Ctrl + V).

6. Drag the code onto a button or into the
Macro window of a button.
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Downloading

You download to the remote control by:

1 Make sure the remote control has charged batteries. 

2 Connect the cable between the PC and the remote control.

3 Verify that the file you have open in MX-980 Editor is the one you want to download to the remote
control.

4 Click on the Download to Remote Control shortcut button on the toolbar or choose Download from
the Communications Menu. Do not move the mouse or touch the keyboard during the download.

TIP - Make sure that the cable plug is solidly connected at both ends.    

Using the Setup Menu

1 Press and Hold both the WATCH and the ENTER button for five seconds.

2 Once the Setup menu appears, you can browse between it’s two pages via the PAGE buttons. It will
automatically time out, or you can press the WATCH or the LISTEN button to exit. 

TIME (MX-980 Only) - Set the clock here, however if you want to change whether it is dis-
played or not, go to INDICATOR on page 2 of the Setup Menu.

BACKLIGHT  (MX-980 and  Only)- Configure the amount of time that the MX-980 will stay lit
after it is picked up.
DISPLAY - You can adjust the brightness and contrast of the display. Keep the setting of color set
to S/W, thus all your changes of device backlighting color will be displayed.
SOUND/BEEP - You can adjust the Volume of the MX-980 speaker. Note that  and  editor offer

BEEP volume to set the volume of the Beeps. If your client prefers silent opera-
tion, simply set the volume to 0.

PICKUP (MX-980 Only) - You can disable the Pick Up Sensor
INDICATOR (MX-980 Only)  - You can disable the display of the Clock, the IR and the Battery
Indicator here.

Finishing the Program
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